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Let’s go!
In minutes, you can install TestTrack Pro and start tracking bugs. Why wait any longer? 

About the installation guide, 2

System requirements, 2

Installation scenarios, 3

Contacting Seapine support, 5
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About the installation guide
This installation guide provides step-by-step instructions for installing TestTrack Pro. The guide 
includes three sections: Windows Installation, UNIX Installation, and Mac Installation.

System requirements
Before installing TestTrack Pro, make sure your computer meets the following system requirements.

TestTrack Pro Windows client

A 486/Pentium PC with at least 32 MB of RAM (64 MB recommended) 

Microsoft Windows (95, 98, ME, XP, NT 4.0, 2000)

VGA or higher-resolution monitor (super VGA recommended) 

TestTrack Pro Web client

Any computer with a Web browser supporting HTML 3.0 or later 

A Web server with the TestTrack Pro Web components installed

TestTrack Pro Server/CGI on Windows or Linux

A Pentium PC with at least 64 MB of RAM. The amount of RAM depends on the number of defects 
the server handles. Contact Seapine support for more information.

Microsoft Windows (95, 98, ME, XP, NT 4.0, 2000) or Linux (kernel 2.2 or later).

TestTrack Pro Server/CGI on Solaris

An UltraSparc processor is required with at least 64MB of RAM

Solaris (version 2.6 or later)

TestTrack Pro Server/CGI on Mac OS X

Power Mac G3, G4, G4 Cube; iMac; PowerBook G3, G4; or iBook computer with at least 128 MB of 
RAM.

Mac OS X (version 10.1 or later)

License Server/CGI on Windows or Linux

A Pentium PC with at least 64 MB of RAM. The amount of RAM depends on the number of defects 
the server handles. Contact Seapine support for more information.

Microsoft Windows (95, 98, ME, XP, NT 4.0, 2000) or Linux (kernel 2.2 or later).
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License Server/CGI on Mac OS X

Power Mac G3, G4, G4 Cube; iMac; PowerBook G3, G4; or iBook computer with at least 128 MB of 
RAM.

Mac OS X (version 10.1 or later)

License Server/CGI on Solaris

An UltraSparc processor is required with at least 64MB of RAM

Solaris (version 2.6 or later)

Installation scenarios
TestTrack Pro’s cross-platform flexibility lets you install the program to best meet your company’s 
needs. The installation scenarios illustrate different ways to install TestTrack Pro.

The following graphic shows an installation of the TestTrack Pro Server on a dedicated server and two 
Windows clients:

The following graphic shows an installation of the TestTrack Pro Server on a dedicated server with full 
Web access, a PC browser client, a Windows client, a Linux browser client, and a Mac browser client:

TestTrack Pro Server 
and Databases

Windows 
Client

Network/Internet

Windows 
Client

TestTrack Pro 
Server, Databases, 
and CGI

PC Browser 
Client

Network/Internet

Linux Browser 
Client

Windows 
Desktop Client

Mac Browser 
Client
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The following graphic shows an installation of the TestTrack Pro Server on a dedicated server with full 
Web access, the CGI running on a Web server, a PC browser client, a Windows client, a UNIX browser 
client, and a Mac browser client:

The following graphic shows an installation of TestTrack Pro Server on a dedicated server with full Web 
access, the CGI running on a Web server, the databases stores in a database server, a PC browser client, a 
Windows client, a Linux browser client, and a Mac browser client:
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Contacting Seapine support 
We offer technical support, 9 AM - 6 PM, EST, Monday - Friday.

Note:  Check our Web site for the latest TestTrack Pro and SoloBug news, answers to 
frequently asked questions, and TestTrack Pro and SoloBug updates. You can also find 
help in our Knowledgebase!

Feedback

Seapine Software welcomes your feedback on the documentation included with this product. If you have 
comments or suggestions about any of the guides or the online help, please send them to: 
documentation@seapine.com.

This email address is provided for documentation only. You may not receive a reply to your email. For 
technical questions or support, contact support@seapine.com.

Telephone 513-754-1655

Email support@seapine.com

Web site www.seapine.com

mailto:support@seapine.com
http://www.seapine.com
http://www.seapine.com
mailto:documentation@seapine.com
mailto:support@seapine.com
http://www.seapine.com/kb.html
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Chapter 2
Windows Installation

Installing TestTrack Pro for Windows
You can install all the components, options, and products that come with TestTrack Pro or choose to 
install a few selected components. A sample database is installed the first time you install TestTrack 
Pro to help you explore all of TestTrack Pro’s features. After installation is complete, you’ll be ready 
to start tracking bugs!

Before installing, 8

Windows installation types, 8

Installing TestTrack Pro, 8

Getting started - new installations, 19

Getting started - new installations, 19 

The servers aren’t communicating. Help!, 22
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Before installing
Make sure your computer meets the recommended system requirements. For more information, see 
System requirements, page 2.

Decide on the type of installation you need to perform.

If you are using Microsoft Windows NT, Windows 2000, or Windows XP, you must be logged in as 
a user with full administrative privileges.

You do not need to uninstall a previous version of TestTrack Pro because the new version is installed 
over any existing version. However, make sure the TestTrack Pro Server application is shutdown 
before the new version of the TestTrack Pro Server application is installed.

Windows installation types
Client installation installs the TestTrack Pro Windows client and SoloBug. This installation is 
recommended for most users.

Server installation installs the TestTrack Pro Windows Server, TestTrack Pro Windows Client, 
TestTrack Pro Server Admin Utility, License Server, License Server Admin Utility, SoloBug, and a 
sample database.If you are the administrator, select this installation the first time you install, if you 
need to reinstall, or if you are upgrading.

Server installation with Web components installs the Track Pro Windows Server, TestTrack Pro Web, 
TestTrack Pro SDK (SOAP components), TestTrack Pro Windows Client, TestTrack Pro Server 
Admin Utility, License Server, License Server Admin Utility, SoloBug, and a sample database.

Server installation with Web and SOAP components installs TestTrack Pro Windows Server, TestTrack 
Pro Web, TestTrack Pro SDK (SOAP components), TestTrack Pro Windows Client, TestTrack Pro 
Server Admin Utility, License Server, License Server Admin Utility, SoloBug, and a sample database.

Custom installation lets you choose the components you want to install.

Note:  If you also use Surround SCM, the license server and the server admin utility may 
already be installed on your network. Check with the Surround SCM administrator.

Installing TestTrack Pro

Note:  The following instructions correspond to a server installation with Web and SOAP 
components. Depending on the components you are installing, you may not be prompted for 
the same information. 

1 Run the installation program.

If you downloaded the installation program from the Seapine Web site, run ttprowininstall.exe. There 
is also a client only installation program named ttprowinclientinstall.exe.
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If you are installing from CD, insert the TestTrack Pro CD into the CD-ROM drive and click Install 
TestTrack Pro.

2 Review the Welcome Screen. Click Next.

3 Read the license agreement and accept the terms. Click Next.

Note:  You must accept the terms of the license agreement to continue the installation.

4 Choose the installation type. Click Next.

For information about installation types, Windows installation types, page 8

5 If Visual Basic 6.0, Visual Studio .Net, or Visual C++ 6.0 is installed on your computer the TestTrack Pro 
Add-In is automatically installed. Click Next.
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6 Select the TestTrack Pro destination directory. TestTrack Pro applications, documentation, and help files 
are installed in this directory. Click Browse to select a different directory.

7 Select the server execution mode. Click Next.

The recommended server execution mode is Run as a service. A service is a program that runs in 
the background. It is started automatically when the system starts and is stopped when the 
system shuts down. If you run the server as an application, you must manually start the 
server.

8 Select a Web server. Click Next.

TestTrack Pro’s Web pages are served by the Web server. When a user logs in to TestTrack Pro Web, the 
Web server calls the TestTrack Pro CGI, which in turn communicates with the TestTrack Pro server.
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9 Enter the IP address or the domain name of the computer that will be running the TestTrack Pro server. 
Click Next.

The IP address is used by the TestTrack Pro Web CGI to communicate with TestTrack Pro server. A static 
IP address is recommended.

10 Enter the TestTrack Pro server port number. Click Next.

The server communicates with TestTrack clients on this port.

11 Select your Web site’s home directory. Click Next.

TestTrack Pro HTML files are installed in this directory. Following are some default directories:

Microsoft IIS and PWSC: C:\Inetpub\wwwroot 

Apache: C:\Program Files\Apache Group\Apache\htdocs 
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Netscape FastTrack\SuiteSpot: C:\Netscape\SuiteSpot\docs

O’Reilly WebSite: C:\WebSite\htdocs 

Other: Web Site Home Directory\htdocs

12 Enter the logical CGI directory name. Click Next.

This directory name follows the http://yourdomain.com/ portion of each Web request to the TestTrack Pro 
Web CGI. Following are some default directories:

Microsoft IIS and PWSC: scripts

Apache: cgi-bin

Netscape FastTrack\SuiteSpot: cgi-bin

O’Reilly WebSite: cgi-shl

Other: cgi-bin 
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13 Select your Web site’s CGI directory location. Click Next.

The installer needs to where CGI files are normally installed. In your Web server configuration there is a 
setting that maps the logical CGI directory to its physical location. Following are some default locations:

Microsoft IIS and PWSC: C:\Inetpub\scripts 

Apache: C:\Program Files\Apache Group\Apache\cgi-bin

Netscape FastTrack\SuiteSpot: C:\Netscape\SuiteSpot\cgi-bin

O’Reilly WebSite: C:\WebSite\htdocs\cgi-shl

Other: Web Site Home Directory\cgi-bin

14 Enter the IP address or the domain name of the computer that is hosting the SOAP CGI. Click Next.
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15 Enter the SOAP Server port number. Click Next.

16 Select the License Server destination directory. The license server applications, documentation, and help 
files are installed in this directory. Click Browse to select a different directory.

17 Select a server execution mode. Click Next.

The recommended server execution mode is Run as a service. If you run the server as an 
application, you must manually start the server.
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18 Enter the license server port number. Click Next.

The license server uses this port to communicate with the TestTrack Pro and Surround SCM servers over 
TCP/IP. It only sends information as a response to a request; it does not push information.

19 The installation begins. A progress indicator opens, showing the location the files are being copied to and 
the remaining time to complete the installation.

20 If you installed the TestTrack Pro server or the License Server as an application, you are prompted to 
select a start server option. Select an option and click Next.
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21 The Installation Completed dialog box opens. 

To view the Installation Notes and/or the Read Me file, select the corresponding check box.

22 Click Finish.

Your installation is complete.

i
Why am I prompted to reboot my computer?

To complete the installation, you may be prompted to reboot your computer for one of the 
following reasons:

1. You installed an NT service. In this case, you do not have to reboot the computer. You can 
start the TestTrack service from the Control Panel.

2. One of the installed files was in use and the installer could not copy the file. The file is 
copied to the correct location when you reboot.

3. The Visual C++ add-in was installed on your computer.
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Getting started - upgrade installations

Note:  This section provides an overview of the steps required to upgrade to TestTrack Pro 
6.0. It is strongly recommended that you read the TestTrack Pro Database Conversion Utility 
guide for more detailed information.

After you install TestTrack Pro 6.0, you need to convert the server database to the current format. During 
the conversion, existing TestTrack Pro users and valid, non-expired licenses are migrated to the license 
server. If you are prompted to convert the database during the installation, start with step 3.

1 After installing TestTrack Pro 6.0, convert the server database to the current format.

Backup the database files before converting to ensure data can be restored if an error occurs.

2 Stop the license server if it is running.

If the license server is installed as an application, right-click the server icon in the taskbar and select 
Terminate Server.

If the license server is installed as a service, use the Services icon in the Control Panel or the Services 
menu under Administrative Tools to stop the server.

3 Login to the Database Conversion Utility using your existing server admin username and password.

Choose Programs > Seapine Software > TestTrack Pro > TestTrack Pro DB Conversion.

4 Select the database you want to convert and click Upgrade Selected Database.

During the conversion, existing TestTrack Pro users (with usernames) and valid, non-expired licenses 
are migrated to the license server. Users that do not have usernames are converted as local users.

Note:  You may be prompted about user conflicts during the conversion if you use Surround 
SCM and TestTrack Pro or if you convert multiple TestTrack Pro databases. For example, 
you convert Surround SCM before TestTrack Pro. A few users were setup using their full 
name (e.g., Deborah) in Surround SCM and using their nicknames (e.g., Debbie) in TestTrack 
Pro. If conflicts are detected, you are prompted to use the current user information on the 
license server or the user information from the database. If users have trouble logging in 
after the conversion, ask them to try both username/password combinations.

5 Click Close to close the Database Conversion Utility.

6 Start the license server.

If the server is installed as an application, choose Programs > Seapine Software > Seapine License Server 
> Seapine License Server.

If the server is installed as a service, use the Services icon in the Control Panel or the Services menu 
under Administrative Tools to start the server.
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7 Start the TestTrack Pro server.

If the server is installed as an application, choose Programs > Seapine Software > TestTrack Pro> 
TestTrack Pro Server.

If the TestTrack Pro is installed as a service, use the Services icon in the Control Panel or the Services 
menu under Administrative Tools to start the server.

If the TestTrack Pro server won’t start, see The servers aren’t communicating. Help!, page 22 for 
troubleshooting information.

8 If you converted dedicated licenses, which are converted as named licenses, you need to select a license 
for users.

Login to the License Server Admin Utility as the default administrative user. The username is 
Administrator and there is no password. 

Choose Programs > Seapine Software > Seapine License Server > Seapine License Server Admin.

Click Users.

Select a user and click Edit.

Click the License tab. Select Used named license and click OK.

Click Close to close the Users window.

Choose File > Exit to close the License Server Admin Utility.

9 Your conversion process is now complete. Users can now login, using their existing usernames and 
passwords, and access TestTrack Pro.

i
Keep the following in mind:
During installation, an administrative user with full admin security rights is created. To login 
as the administrative user, enter Administrator as the username and leave the password 
blank. You can delete this user and add a new admin user. If you do not want to delete this 
user, you should add a password to prevent unauthorized users from logging in to an 
administrator account.
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Getting started - new installations
After TestTrack Pro 6.0 is installed, you need to set up a connection between the license server and 
TestTrack Pro server, add licenses and users to the license server, and start using TestTrack Pro.

Note:  Steps 1-6 may not be necessary if you install the TestTrack Pro server and the license 
server on the same computer, using the default port configurations.

1 Make sure the license server is running.

If the server is installed as an application, choose Programs > Seapine Software > Seapine License Server 
> Seapine License Server.

If the license server is installed as a service, use the Services icon in the Control Panel or the Services 
menu under Administrative Tools to start the server.

2 Start the License Server Admin Utility to setup a local server connection, add licenses, and add users.

The Seapine License Server Login dialog box opens.

3 Click Setup to add a server connection.

The Setup Server List dialog box opens.

4 Click Add.

The Add License Server dialog box opens.

5 Enter a Server Name, Server Address, and Port Number. Click OK.

The server is added.

6 Click Close to return to the License Server Login dialog box.

7 Login as the default administrative user. The username is Administrator and there is no password.

By default, Administrator has full admin security rights and uses a TestTrack Pro floating license. It is 
strongly recommended that you set a password for this user after logging in.

8 Click Connect.

The License Server Admin Utility starts. You are now ready to add licenses and users.

Adding licenses
1 Click Licenses or choose View > Licenses.

The Licenses dialog opens.

2 Click Add.

The Add License dialog box opens.
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3 Enter the serial number.

This field is not case sensitive. Licenses can be entered with or without dashes.

4 Click OK.

The license is added. Click Close to close the Licenses dialog.

Adding users
The license server is used to globally manager users. Global users can be shared between Seapine 
products and databases.

1 Click Users or choose View > Users.

The Users dialog box opens.

2 Click Add.

The Add User dialog box opens with the Info tab selected. Enter the user information.

3 Optionally, click the Address tab to add the company name and address.

4 Optionally, click the Email/Phone tab to add contact information.

5 Click the License tab to select the license type for the user.

If a license is not selected, the user will not be able to login or access TestTrack Pro.

6 Click the Notes tab to add any optional notes about the user.

7 Click the Security tab to set the license server security rights for the user. 

Most users do not require access to the license server admin utility.

8 Click OK to save the information and add the user.

The users you added are global users that can be shared between Seapine products and databases.

9 Click Close when you finish adding users.

10 Quit the License Server Admin Utility.

Next, you’ll switch to TestTrack Pro and retrieve global users.

Getting starting with TestTrack Pro
1 Start the TestTrack Pro Server Admin Utility and login as the default administrative user. 

The username is Administrator and there is no password. By default, Administrator has full admin 
security rights and uses a TestTrack Pro floating license. It is strongly recommended that you set a 
password for this user.
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2 Add a server and create at least one database.

See the Server Admin Utility Guide for more information.

3 Next, start TestTrack Pro and login as the default administrative user.

4 To retrieve users from the license server choose View > Users then click Add Global. Select the users and 
click Add.

The users you added to the license server can now access TestTrack Pro.

5 Your installation and setup process is now complete.

i
Where to go next...

If you are the TestTrack Pro administrator, make sure the license server and the TestTrack 
Pro server are both started. After starting TestTrack Pro, take the time to set database 
options, create security groups, and configure TestTrack Pro to meet your company’s 
business process. See the TestTrack Pro User Guide (Windows or Web) for more information.
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The servers aren’t communicating. Help!
If the servers aren’t connecting, you need to start the server admin utility and check the license server 
information.

1 Make sure the license server and the TestTrack Pro server are both started.

2 Start the TestTrack Pro server admin utility and login using your existing server admin username and 
password.

If your username and password are not recognized, you can use the local TTPro admin password, 
leaving the username blank and entering admin as the password. This password only provides access to 
the license server configuration.

Note:  It is strongly recommended that you change the local TTPro admin password, which 
only provides access to the license server configuration. To change this password, login to 
the TestTrack Pro server admin utility using the Administrator account or your existing admin 
username/password. Select Server Options then click the Server tab. Enter and confirm a 
new local TTPro admin password and click OK.

3 Click Server Options.

The Options window opens with the License Server tab selected.

4 Make sure the server address and port number are both correct.

5 Click Test Connection.

A message opens, letting you know if the connection is successful. If the TestTrack Pro server and the 
license server are installed on different computers, you may need to check your network and firewall 
configurations to open the necessary ports.

6 Click OK to close the message.

If the connection was not successful, correct any mistakes and re-test the connection.

If the connection was successful, click OK to close the server options.

i
You may need to manually configure the connection for one of the following reasons:

1. You changed the default TestTrack Pro or license server address or port number.

2. You installed the TestTrack Pro server and the license server on different computers.

7 Stop and restart the TestTrack Pro server for the changes to take affect.
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Chapter 3
Unix Installation

Installing TestTrack Pro for Unix
This section introduces you to the various components of the Unix TestTrack Pro architecture and 
explains how to install the components. TestTrack Pro can be installed using a graphical installer or 
a command line Perl installer. TestTrack Pro currently supports the following Unix platforms: Solaris 
(Sparc) and Linux (Intel).

Installation notes, 24

Unix installation components, 24

Unix graphical installer, 26

Unix command line installer, 29

Getting started - upgrade installations, 32

Getting started - new installations, 34

The servers aren’t communicating. Help!, 37
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Installation notes
The command line installer is written in Perl and requires Perl version 5 or later. The graphical installer 
is written in Java and requires JDK (Java Development Kit) or JRE (Java Runtime Environment) 1.3.1.

Linux
Linux kernel 2.0.x is not supported. The TestTrack Pro server requires multiple open file handles and 
kernel 2.0 automatically limits you to 256 files per process. TestTrack Pro will probably work but you 
will not be able to open more than a couple of databases.

Glibc version 2.1.3 and version 2.1.92 are supported

libstdc++ version 2.9.0 is required

Mandrake 8.0 is supported

Mandrake (Linux)
Linux 2.2 kernel

The following libraries are required: libstdc++-libc6.2-2.so.3, libc.so.6, libm.so.6, libpthread.so.0

Note:  Make sure the OS and libraries are compiled with the gcc-2.96 compiler, NOT the 
egcs based compiler used by Red Hat 6.2.

Solaris
Sparc requires libstdc++so.2.10.0

Unix installation components
If you choose a custom installation, you can select any or all of the following components:

TestTrack Pro Server

TestTrack Pro Web Client

TestTrack Pro Web Server Admin Utility

SoloSubmit

SOAP Server

Sample database

Seapine License Server Admin Utility

Seapine License Server
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TestTrack Pro configuration file values
The TestTrack Pro configuration file, ttpro.conf, includes required and optional variables.

Optional variables
Optional variables are used to define custom web installations, apply security, and allow optional 
database paths.

ServerPort: Port the TestTrack Pro server uses to communicate with TestTrack clients.

LogDirectory: Directory where the startup.log file is written.

ApplicationDirectory: Directory where TestTrack Pro server database files and SoloBug import 
directories are stored.

ServerAddress:  IP address the cgi client uses to find the TestTrack Pro server.

FormsPath: Full path of the TestTrack Pro Web pages.

ShortDateFormat: Format that date strings should be output in.

AdminFormsPath: Full path of the TestTrack Pro Admin Web pages.

admin-cgi-bin: Location and name of the TestTrack ttadmcgi.exe script

ShortDateFormat: TestTrack Pro Web short date format

LicenseServerPort: The license server uses this port to communicate with the TestTrack Pro and 
Surround SCM servers over TCP/IP.

LicenseServerAddress: The license server IP address.

HTMLPath: Relative TestTrack Pro HTML files alias location path. Use the following 
format: alias/sub-alias/sub-sub-alias. Do not start or end with “/”.

AdminHTMLPath: Relative TestTrack Pro Server Admin files alias location path. Use the 
following format: alias/sub-alias/sub-sub-alias. Do not start or end with 
“/”.

AllowPathForDB: Set the value to 1 to create and add databases using full directory paths.

RebootServerPort: Used by the TestTrack Pro server to determine the reboot port. This value is 
automatically recorded during the installation process.

SkipWebConnectIPCheck: Set the value to 1 to skip the security check. If the IP address changes in mid-
session, the connection is not dropped.

WebReloginIPCheck: Set the value to 1 to restrict users from logging in to TestTrack Pro Web from 
another location. Users can log in from their original location if the session 
is still active.
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License server configuration file values
The license configuration file, splicsvr.conf, includes required variables.

Unix graphical installer

i
If you are upgrading TestTrack Pro, you may be prompted to overwrite existing HTML, 
SoloSubmit, and Admin HTML files. If you choose not to overwrite the files, you may not 
install all bug fixes or new features. Depending on the extent of the changes, choosing not 
to overwrite may result in TestTrack Pro functioning incorrectly.

Default answers are provided for most questions. You can accept the default or enter another answer.

1 Download the installation program.

The Linux installation file is named ttprolinuxjavainstall.bin. 

The Solaris installation file is named ttprosolarissparcjavainstall.bin.

2 Run the corresponding file by logging in as root and double-clicking the file in the Window Manager.

Note:  You can also su to root and run the file from a terminal application. X-Windows must 
be running to use the installer.

3 The Introduction dialog opens. Click Next.

4 Select the installation folder. Click Next.

5 Select the type of installation you want to perform. Click Next.

Note:  If you are performing an Easy Install, the installation starts automatically. Follow the 
instructions to finish the installation. You may be prompted to enter additional information, 
such as the path to the CGI directory.

6 If you are performing a Custom Install, the Choose Product Components dialog opens.

ServerPort: The TestTrack Pro server uses this port to communicate with TestTrack Pro 
clients.

LogDirectory:  Directory where the license server log file is written.

ApplicationDirectory: Directory where the license server database files are stored.

ShortDateFormat: Format that date strings should be output in.

AllowPathForDB: Set the value to 1 to create and add databases using full directory paths.
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7 Select the components you want to install. Click Next.

8 Enter the location of the TestTrack Pro application directory. Click Next.

The TestTrack Pro server stores all of the database files and SoloBug import directories in this directory.

9 Enter the location of the Unix command directory. Click Next.

The TestTrack Pro server daemon is installed in this directory.

10 Enter the directory where the startup log file will be written. Click Next.

The log file contains messages about any errors that occur when starting the TestTrack Pro server.

11 Enter the TestTrack Pro server port number. Click Next.

The TestTrack Pro server uses this port to communicate with TestTrack Pro clients.

12 Enter the maximum number of open files. Click Next.

TestTrack Pro requires approximately 200 open files per database.

13 Select the check box to automatically start the TestTrack Pro server during the boot sequence. Click Next.

14 Enter the IP address or domain name of the TestTrack server. Click Next.

The TestTrack Pro Web CGI uses this address to communicate with the TestTrack Pro server.

15 Enter the HTML files directory. Click Next.

The directory must be accessible by your Web server to ensure users can access the pages.

16 Enter the path to the CGI directory. Click Next.

When a user logs in to TestTrack Pro from a Web browser, your Web server calls the TestTrack Pro CGI.

17 Enter the IP address or domain name of the computer that is hosting the SOAP CGI. Click Next.

Use the IP address or domain name of the computer that you are currently installing TestTrack Pro on, 
since it will be hosting the SOAP CGI. The SOAP CGI requires this information

18 Enter the port number the Web server hosting the SOAP CGI will listen on. Click Next.

19 Enter the short date format you want to use. Click Next.

The date format is used for trend reports, email notifications, the startup log file, and any other date 
string created by the TestTrack Pro server.

Valid date formats include: “%m/%d/%y”, “%d/%m/%y”, “%b/%d/%y”, or “%d/%b/%y”. Other variations 
of this date format include substituting %b with %B or substituting %y with %Y. The year parameter 
must be last in the date format (e.g., “%y/%m/%d” is invalid). 
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Valid delimiters between the month, day, and year values include a period, dash, forward slash, 
backward slash, comma, or a space. 

%b Abbreviated month name

%B Full month name

%d Day of the month, 01-31

%m Month of the year, 01-12

%y Last two digits of the year number, 00-99

%Y Year

20 Enter the license server application directory location. Click Next.

The license server database files are stored in this directory.

21 Enter the license server Unix command directory. Click Next.

The license server executables are installed in this directory. 

22 Enter the directory where the license server startup log file will be stored. Click Next.

The log file contains messages about any errors that occur when the license server starts.

23 Enter the license server port number. Click Next.

The license server uses this port to communicate with the TestTrack Pro and Surround SCM servers over 
TCP/IP. It only sends information as a response to a request; it does not push information.

24 Enter the maximum number of open files for the license server. Click Next.

The license server requires approximately 200 open files per database. There are no known negative side 
effects of leaving this set to the maximum (65535).

25 The Pre-Installation Summary dialog opens. Review the information. Click Next if the information is 
correct. Click Previous to make changes.

Note:  Pre-Installation Summary dialogs open for each component you are installing. For 
example, the Pre-Installation Summary: Server dialog opens for you to review the server 
installation information.

26 After reviewing all Pre-Installation Summary information, click Install, on the last Summary dialog that 
opens, to begin the installation.

27 The Install Complete dialogs opens after TestTrack Pro is installed.
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28 Click Done to close the Install Complete dialog.

When the installation finishes, you are ready to start using TestTrack Pro. See Getting started - upgrade 
installations, page 32 and Getting started - new installations, page 34 for information about getting started. 

Unix command line installer
The installation script automates the process of installing TestTrack Pro for Unix. You are asked several 
questions about the installation. Default answers are provided after the question (in square brackets). To 
accept the default, press Enter. You can cancel the installation at any time by pressing Ctrl+C.

Note:  If you are installing from CD, all you need to do is cd into the appropriate directory 
and run the installer. Begin with step 2.

1 Copy the file to a working directory. Then untar and gunzip it. 

The de-archiving process installs the appropriate files in subdirectories it creates. The Linux installation 
file is named ttprolinuxinstall.tar.gz. The Solaris installation file is named ttprosolarissparcinstall.tar.gz.

Use the following command for a Linux installation:

tar -xvf filename

Use the following commands for a Solaris installation:

gunzip filename.tar.gz

tar xvf filename.tar

2 Change to the TestTrack Pro directory.

The directory changes based on the version of TestTrack Pro you are installing. For example: cd ttpro-4.X

3 To run the install script, enter ./ install.pl

The installation script starts.

Note:  The following instructions correspond to a server installation with Web and SOAP 
components. Depending on the type of installation you are performing, you may not be 
prompted for the same information. 

4 Choose the type of installation you want to perform.

You can select all, or a few, components. 

5 Enter the user id the server will run under.

Running any application with an unprivileged account ensures limited exposure in the unlikely event of 
an exploit in the software. Because the user will only own files related to TestTrack Pro, the rest of you 
system will be secure if the user id is compromised.
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6 Enter the TestTrack Pro application directory.

The directory is created if it does not exist. TestTrack Pro database files and SoloBug import directories 
are stored in this directory.

7 Enter the TestTrack Pro server port number.

The TestTrack Pro server uses this port to communicate with TestTrack Pro clients. If you are installing 
the TestTrack Pro server and CGI on different computers, make sure you specify the same port number 
for both installs.

8 Enter the directory where the startup log file will be written. Click Next.

The log file contains messages about any errors that occur when starting the TestTrack Pro server.

9 You are prompted to choose if you want TestTrack Pro to start at boot time.

Enter Y (yes) or N (no). 

10 Enter the location of the Unix command directory.

This directory contains public executable Unix programs and shell scripts. The TestTrack Pro server 
daemon is also installed in this directory.

11 Enter the maximum number of open files.

TestTrack Pro requires approximately 200 open files per database. There are no known negative side 
effects of leaving this set to the maximum (65535).

12 The installer searches for the Web server configuration file.

After the search is complete, enter the number that corresponds to the httpd.conf file you are using.

13 Enter the server IP address.

The cgi client uses this IP address to find the TestTrack Pro server. If the server is running on the same 
machine as the cgi client, use ‘127.0.0.1’.

14 Select the server name your Web server responds to.

15 Enter the HTML files directory location.

The ttweb/ subdirectory, which contains the HTML files the TestTrack Pro Web client uses, is installed 
in this directory.

16 Enter the Administration HTML files directory location.

The ttweb/ttadmin subdirectory, which contains the HTML files the TestTrack Pro Web Admin client 
uses, is installed in this directory.

17 Enter the path to your CGI directory.

18 Enter the path to your CGI Administration directory.
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19 Enter the TestTrack Web client URL.

If the suggested URL is correct, press Enter. To use a different URL, press [N] then enter the URL.

20 Enter the TestTrack Web Admin client URL.

If the suggested URL is correct, press Enter. To use a different URL, press [N] then enter the URL.

21 Enter the IP address of the web server that will be hosting SOAP.

22 Enter the port number of the web server that will be hosting SOAP.

23 Enter the short date format you want to use.

The date format is used for trend reports, email notifications, the startup log file, and any other date 
string created by the TestTrack Pro server.

Valid date formats include: “%m/%d/%y”, “%d/%m/%y”, “%b/%d/%y”, or “%d/%b/%y”. Other variations 
of this date format include substituting %b with %B or substituting %y with %Y. The year parameter 
must be last in the date format (e.g., “%y/%m/%d” is invalid). Valid delimiters between the month, day, 
and year values include a period, dash, forward slash, backward slash, comma, or a space.

Elements in the date format have the following functionality:

%b Abbreviated month name

%B Full month name

%d Day of the month, 01-31

%m Month of the year, 01-12

%y Last two digits of the year number, 00-99

%Y Year

24 Enter the license server application directory location. Click Next.

The license server database files are stored in this directory.

25 Enter the license server Unix command directory. Click Next.

The license server executables are installed in this directory.

26 Enter the directory where the license server startup log file will be stored. Click Next.

The log file contains messages about any errors that occur when the license server starts.

27 Enter the license server port number. Click Next.

The license server uses this port to communicate with the TestTrack Pro and Surround SCM servers over 
TCP/IP. It only sends information as a response to a request; it does not push information.
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28 Enter the maximum number of open files for the license server. Click Next.

The license server requires approximately 200 open files per database.

29 A summary of the installation options you chose opens.

The summary includes a list of the TestTrack Pro products you are installing and the information you 
entered.

30 If the information is correct, press enter. Press [N] to restart the installer.

The installation begins. When the installation finishes, you are ready to start using TestTrack Pro. See 
Getting started - upgrade installations, page 32 and Getting started - new installations, page 34 for more 
information.

Getting started - upgrade installations
After you install TestTrack Pro 6.0, you need to convert the server database to the current format. During 
the conversion, existing TestTrack Pro users and valid, non-expired licenses are migrated to the license 
server. If you are prompted to convert the database during the installation, start with step 3.

Note:  You should backup the database files before converting the database. This ensures 
data can be restored if an error occurs during the conversion.

1 After installing TestTrack Pro 6.0, convert the server database to the current format.

2 Enter ./spls stop to stop the license server.

3 To run the database conversion utility, you must be logged in to the server computer as the root user.

Note:  The conversion utility must be run from X Windows.

4 Change to the TestTrack Pro application directory

cd /var/lib/ttpro (Linux)

cd /opt/ttpro (Solaris)

5 Enter ./ttdbconversion to start the database conversion utility.

The conversion utility starts.
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6 Select the database you want to convert and click Upgrade Selected Database.

During the conversion, TestTrack Pro users with usernames and valid, non-expired licenses are added to 
the license server. Users that do not have usernames are converted as local users.

Note:  You may encounter user conflicts during the conversion if you use Surround SCM and 
TestTrack Pro or if you convert multiple TestTrack Pro databases. If conflicts are detected, 
you are prompted to either use the current user information on the license server or the user 
information from the database you are converting. If users have trouble logging in after the 
conversion, ask them to try both username/password combinations.

7 Click Close to close the Database Conversion Utility.

8 Start the license server. Make sure you are in the directory where startup scripts are located. This is 
generally either the /etc/init.d directory or the /usr/bin directory. 

Enter ./spls start to start the server as a daemon

Enter ./spls foreground to start the server in the foreground

9 Start the TestTrack Pro server. Make sure you are in the directory where startup scripts are located. This 
is generally either the /etc/init.d directory or the /usr/bin directory.

Enter ./ttpro start to start the server as a daemon

Enter ./ttpro foreground to start the server in the foreground

10 If you converted dedicated licenses, which are converted as named licenses, you need to select a license 
for users. 

Enter ./lsadmin & to start the license server admin utility. Make sure you are in the directory where 
startup scripts are located. This is generally either the /etc/init.d directory or the /usr/bin directory.

Login as the default administrative user. The username is Administrator and there is no password. 

Click Users.

Select a user and click Edit.

Click the License tab. Select Used named license and click OK.

Click Close to close the Users window.

Choose File > Exit to close the License Server Admin Utility.
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11 Your conversion process is now complete. Users can now login, using their existing usernames and 
passwords, and access TestTrack Pro.

i
Keep the following in mind:
During installation, an administrative user with full admin security rights is created. To login 
as the administrative user, enter Administrator as the username and leave the password 
blank. You can delete this user and add a new license server admin user. If you do not want 
to delete this user, you should add a password to prevent unauthorized users from logging 
in to an administrator account.

Getting started - new installations
After TestTrack Pro 6.0 is installed, you need to set up a connection between the license server and 
TestTrack Pro server, add licenses and users to the license server, and start using TestTrack Pro.

Note:  Steps 1-6 may not be necessary if you install the TestTrack Pro server and the license 
server on the same computer, using the default port configurations.

1 Start the license server. Make sure you are in the directory where startup scripts are located. This is 
generally either the /etc/init.d directory or the /usr/bin directory. 

Enter ./spls start to start the server as a daemon

Enter ./spls foreground to start the server in the foreground

2 Start the license server admin utility. Make sure you are in the directory where startup scripts are located. 
This is generally either the /etc/init.d directory or the /usr/bin directory.

Enter ./lsadmin & to start the license server admin utility

3 Click Setup on the Seapine License Server Login dialog box to add a server connection.

The Setup Server List dialog box opens.

4 Click Add.

The Add License Server dialog box opens.

5 Enter a Server Name, Server Address, and Port Number. Click OK.

The server is added.

6 Click Close to return to the License Server Login dialog box.
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7 Login as the default administrative user. The username is Administrator and there is no password. 

By default, Administrator has full admin security rights and uses a TestTrack Pro floating license. It is 
strongly recommended that you set a password for this user after logging in.

8 Click Connect.

The License Server Admin Utility starts. You are now ready to add licenses and users.

Adding licenses
1 Click Licenses or choose View > Licenses.

The Licenses dialog opens.

2 Click Add.

The Add License dialog box opens.

3 Enter the serial number.

This field is not case sensitive. Licenses can be entered with or without dashes.

4 Click OK.

The license is added. Click Close to close the Licenses dialog.

Adding users
The license server is used to globally manager users. Global users can be shared between Seapine 
products and databases.

1 Click Users or choose View > Users.

The Users dialog box opens.

2 Click Add.

The Add User dialog box opens with the Info tab selected. Enter the user information.

3 Optionally, click the Address tab to add the company name and address.

4 Optionally, click the Email/Phone tab to add contact information.

5 Click the License tab to select the license type for the user.

If a license is not selected, the user will not be able to login or access TestTrack Pro.

6 Click the Notes tab to add any optional notes about the user.

7 Click the Security tab to set the license server security rights for the user. 

Most users do not require access to the license server admin utility.
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8 Click OK to save the information and add the user.

The users you added are global users that can be shared between Seapine products and databases.

9 Click Close when you finish adding users.

10 Quit the License Server Admin Utility. Do not stop the license server.

Next, you’ll start TestTrack Pro and retrieve global users.

Getting starting with TestTrack Pro
1 Start the TestTrack Pro server. Make sure you are in the directory where startup scripts are located. This 

is generally either the /etc/init.d directory or the /usr/bin directory. 

Enter ./spls start to start the server as a daemon

Enter ./spls foreground to start the server in the foreground

2 Start a Web browser and enter the URL to access the Server Admin Utility.

Enter the static server address or the IP address and the path to the admin login page. 

For example: <http://127.0.0.1/ttweb/ttadmin/adminlogin.htm> or 
<http://www.yourserver.com/ttweb/ttadmin/adminlogin.htm>

3 The Welcome to TestTrack Pro - Server Admin page opens.

The Login to TestTrack Pro Server Admin dialog should automatically open. If it does not open, click Go 
To Login on the Welcome page.

4 Enter a Username and Password and click Login.

Note:  A default administrative user is added to the server admin utility during installation. 
Login as this user the first time you start the server admin utility. The username is 
Administrator and there is no password. After logging in, you add at least one admin user 
to the server.

The TestTrack Pro Server Admin Main page open

5 Add a server and create at least one database.

See the TestTrack Pro Server Admin Utility Guide for more information.

6 Next, login to TestTrack Pro Web as the default administrative user.

7 Open a web browser and enter the static server address or the IP address and the path to the TestTrack 
Pro Web login page. 

For example: <http://127.0.0.1/ttweb/login.htm> or <http://www.yourserver.com/ttweb/login.htm>
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8 Login as the default administrative user. The default administrative username is Administrator and there 
is no password.

You are now logged in and ready to start using TestTrack Pro.

9 To retrieve users from the license server click the Users tab then click Add Global.

The Add Global User to Current Database dialog opens.

10 Select the users and click OK.

The users you added to the license server can now access TestTrack Pro.

11 The installation and setup process is now complete.

i
After starting TestTrack Pro, take the time to set database options, create security groups, 
and configure TestTrack Pro to meet your company’s business process. See the TestTrack Pro 
User and Admin Guide for more information.

The servers aren’t communicating. Help!
If the servers aren’t connecting, you need to start the server admin utility and check the license server 
information.

1 Make sure the license server and the TestTrack Pro server are both started.

2 Start the TestTrack Pro server admin utility and login.

If your username and password are not recognized, you can connect with the local TTPro admin 
password, leaving the username blank and entering admin as the password. This password only 
provides access to the license server configuration.

Note:  It is strongly recommended that you change the local TTPro admin password, which 
only provides access to the license server configuration. To change this password, login to 
the TestTrack Pro server admin utility using the Administrator account or your existing admin 
username/password. Select Server Options then click the Server tab. Enter and confirm a 
new local TTPro admin password and click OK.

3 Click Server Options.

The Options window opens with the License Server tab selected.

4 Make sure the server address and port number are both correct.
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5 Click Test Connection.

A message opens, letting you know if the connection is successful. If the TestTrack Pro server and the 
license server are installed on different computers, you may need to check your network and firewall 
configurations to open the necessary ports.

6 Click OK to close the message.

If the connection was not successful, correct any mistakes and re-test the connection.

If the connection was successful, click OK to close the server options.

i
You may need to manually configure the connection for one of the following reasons:

1. You changed the default TestTrack Pro or license server address or port number.

2. You installed the TestTrack Pro server and the license server on different computers.

7 Stop and restart the TestTrack Pro server for the changes to take affect.
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Mac installation components
If you choose a custom installation, you can select any or all of the following components:

TestTrack Pro Server

TestTrack Pro Web Client

TestTrack Pro Web Server Admin Utility

SoloSubmit

SOAP Server

Sample Database

Seapine License Server Admin Utility

Seapine License Server

TestTrack Pro configuration file values
The TestTrack Pro configuration file, ttpro.conf, includes required and optional variables.

ServerPort: Port the TestTrack Pro server uses to communicate with TestTrack clients.

LogDirectory: Directory where the startup.log file is written.

ApplicationDirectory: Directory where TestTrack Pro server database files and SoloBug import 
directories are stored.

ServerAddress:  IP address the cgi client uses to find the TestTrack Pro server.

FormsPath: Full path of the TestTrack Pro Web pages.

ShortDateFormat: Format that date strings should be output in.

AdminFormsPath: Full path of the TestTrack Pro Admin Web pages.

admin-cgi-bin: Location and name of the TestTrack ttadmcgi.exe script

ShortDateFormat: TestTrack Pro Web short date format

LicenseServerPort: The license server uses this port to communicate with the TestTrack Pro and 
Surround SCM servers over TCP/IP.

LicenseServerAddress: The license server IP address.
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Optional variables
Optional variables are used to define custom web installations, apply security, and allow optional 
database paths.

License server configuration file values
The license configuration file, splicsvr.conf, includes required variables.

HTMLPath: Relative TestTrack Pro HTML files alias location path. Use the following 
format: alias/sub-alias/sub-sub-alias. Do not start or end with “/”.

AdminHTMLPath: Relative TestTrack Pro Server Admin files alias location path. Use the 
following format: alias/sub-alias/sub-sub-alias. Do not start or end with 
“/”.

AllowPathForDB: Set the value to 1 to create and add databases using full directory paths.

RebootServerPort: Used by the TestTrack Pro server to determine the reboot port. This value is 
automatically recorded during the installation process.

SkipWebConnectIPCheck: Set the value to 1 to skip the security check. If the IP address changes in mid-
session, the connection is not dropped.

WebReloginIPCheck: Set the value to 1 to restrict users from logging in to TestTrack Pro Web from 
another location. Users can log in from their original location if the session 
is still active.

ServerPort: The TestTrack Pro server uses this port to communicate with TestTrack Pro 
clients.

LogDirectory:  Directory where the license server log file is written.

ApplicationDirectory: Directory where the license server database files are stored.

ShortDateFormat: Format that date strings should be output in.

AllowPathForDB: Set the value to 1 to create and add databases using full directory paths.
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Installing TestTrack Pro

i
If you are performing an upgrade of TestTrack Pro, you may be prompted to overwrite 
existing files. If you choose not to overwrite the files, you may not install all bug fixes or new 
features. Depending on the extent of the changes, choosing not to overwrite may result in 
TestTrack Pro functioning incorrectly.

1 Download the installation program.

After the download is complete, it should automatically unstuff into a disk image file called 
ttpromacosxinstall.dmg. 

2 Double-click the ttpromacosxinstall.dmg file to mount the image on the desktop.

3 Double-click the TestTrack Pro disk image.

4 Double-click the Install TestTrack Pro icon.

The Authentication dialog opens.

5 Click the lock to make changes. 

The Authenticate dialog box opens. Enter your name and password and click OK.

Note:  The following instructions correspond to an installation of all TestTrack Pro 
components. Depending on the type of installation you are performing, you may not be 
prompted for the same information. 

6 The Introduction dialog opens. Click Next.

7 Select the installation folder. Click Next.

8 Select the type of installation you want to perform. Click Next.

Note:  If you are performing an Easy Install, the installation starts automatically. Follow the 
instructions to finish the installation. You may be prompted to enter additional information, 
such as the path to the CGI directory.

9 If you are performing a Custom Install, the Choose Product Components dialog opens.

10 Select the components you want to install. Click Next.

11 Enter the location of the TestTrack Pro application directory. Click Next.

The TestTrack Pro server stores all of the database files and SoloBug import directories in this directory.
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12 Enter the location of the Unix command directory. Click Next.

The TestTrack Pro server daemon is installed in this directory.

13 Enter the directory where the startup log file will be written. Click Next.

The log file contains messages about any errors that occur when starting the TestTrack Pro server.

14 Enter the TestTrack Pro server port number. Click Next.

The TestTrack Pro server uses this port to communicate with TestTrack Pro clients.

15 Enter the maximum number of open files. Click Next.

TestTrack Pro requires approximately 200 open files per database.

16 Enter the IP address or domain name of the TestTrack server. Click Next.

The TestTrack Pro Web CGI uses this address to communicate with the TestTrack Pro server.

17 Enter the HTML files directory. Click Next.

The directory must be accessible by your Web server to ensure users can access the pages.

18 Enter the path to the CGI directory. Click Next.

When a user logs in to TestTrack Pro from a Web browser, your Web server calls the TestTrack Pro CGI.

19 Enter the IP address or domain name of the computer that is hosting the SOAP CGI. Click Next.

Use the IP address or domain name of the computer that you are currently installing TestTrack Pro on, 
since it will be hosting the SOAP CGI. The SOAP CGI requires this information

20 Enter the port number the Web server hosting the SOAP CGI will listen on. Click Next.

21 Enter the short date format you want to use. Click Next.

The date format is used for trend reports, email notifications, the startup log file, and any other date 
string created by the TestTrack Pro server.

Valid date formats include: “%m/%d/%y”, “%d/%m/%y”, “%b/%d/%y”, or “%d/%b/%y”. Other variations 
of this date format include substituting %b with %B or substituting %y with %Y. The year parameter 
must be last in the date format (e.g., “%y/%m/%d” is invalid). 

Valid delimiters between the month, day, and year values include a period, dash, forward slash, 
backward slash, comma, or a space. 

%b Abbreviated month name

%B Full month name

%d Day of the month, 01-31
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%m Month of the year, 01-12

%y Last two digits of the year number, 00-99

%Y Year

22 Enter the license server application directory location. Click Next.

The license server database files are stored in this directory.

23 Enter the license server Unix command directory. Click Next.

The license server executables are installed in this directory. 

24 Enter the directory where the license server startup log file will be stored. Click Next.

The log file contains messages about any errors that occur when the license server starts.

25 Enter the license server port number. Click Next.

The license server uses this port to communicate with the TestTrack Pro and Surround SCM servers over 
TCP/IP. It only sends information as a response to a request; it does not push information.

26 Enter the maximum number of open files for the license server. Click Next.

The license server requires approximately 200 open files per database. There are no known negative side 
effects of leaving this set to the maximum number of open files.

27 The Pre-Installation Summary dialog opens. Review the information. Click Next if the information is 
correct. Click Previous to make changes.

Note:  Pre-Installation Summary dialogs open for each component you are installing. For 
example, the Pre-Installation Summary: Server dialog opens for you to review the server 
installation information.

28 After reviewing all Pre-Installation Summary information, click Install, on the last Summary dialog that 
opens, to begin the installation.

29 The Install Complete dialogs opens after TestTrack Pro is installed.

30 The Read Me First file opens.

Be sure to read the information in this file. It helps you en sure TestTrack Pro is installed and working 
correctly.

31 Click Done to close the Install Complete dialog.
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32 The TestTrack Pro preferences dialog opens so you can start the TestTrack Pro server. Click the lock to 
make changes. 

Make sure the server is started. You should also select Start TestTrack Pro Server when this computer starts 
up to automatically start the server.

33 Installation is complete. You are ready to start tracking bugs!

See Getting started - upgrade installations, page 45 and Getting started - new installations, page 47 for 
information about getting started.

Getting started - upgrade installations
After you install TestTrack Pro 6.0, you need to convert the server database to the current format. During 
the conversion, existing TestTrack Pro users and valid, non-expired licenses are migrated to the license 
server. If you are prompted to convert the database during the installation, start with step 3.

Note:  You should backup the database files before converting the database. This ensures 
data can be restored if an error occurs during the conversion.

1 After installing TestTrack Pro 6.0, convert the server database to the current format.

2 Stop the license server if it is running.

3 Logon to the machine as root.

4 In the finder window, go to the TestTrack Pro application directory.

The default location is: /Applications/TestTrackPro

5 Double-click the TestTrack Pro DB Conversion icon to start the database conversion utility.

The conversion utility starts.

6 Select the database you want to convert and click Upgrade Selected Database.

During the conversion, TestTrack Pro users with usernames and valid, non-expired licenses are added to 
the license server. Users that do not have usernames are converted as local users.

Note:  You may encounter user conflicts during the conversion if you use Surround SCM and 
TestTrack Pro or if you convert multiple TestTrack Pro databases. If conflicts are detected, 
you are prompted to use the current user information on the license server or the user 
information from the database you are converting. If users have trouble logging in after the 
conversion, ask them to try both username/password combinations.

7 Click Close to close the Database Conversion Utility.
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8 Start the license server.

Start the System Preferences and click Seapine License Server.

Click the lock on the Start/Stop tab to make changes.

Make sure the server is started. Select Start Seapine License Server when this computer starts up to 
automatically start the server.

Click Save.

9 Start the TestTrack Pro server.

Start the System Preferences and click TestTrack Pro Server.

Click the lock on the Start/Stop tab to make changes. 

Make sure the server is started. Select Start TestTrack Pro Server when this computer starts up to 
automatically start the server.

10 Start the License Server Admin Utility.

Go to the TestTrack Pro application directory. The default location is: /Applications/TestTrackPro.

Double-click Seapine License Server Admin Utility. The license server admin utility starts.

11 Login to the License Server Admin Utility as the default administrative user. 

The username is Administrator and there is no password.

12 If you converted dedicated licenses, which are converted as named licenses, you need to select a license 
for users.

Click Users.

Select a user and click Edit.

Click the License tab. Select Used named license and click OK.

Click Close to close the Users window.

13 Choose File > Exit to close the License Server Admin Utility.

14 The conversion process is complete. Users can login, using their existing usernames and passwords, and 
access TestTrack Pro.
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Getting started - new installations
After TestTrack Pro 6.0 is installed, you need to set up a connection between the license server and 
TestTrack Pro server, add licenses and users to the license server, and start using TestTrack Pro.

Note:  Steps 1-6 may not be necessary if you install the TestTrack Pro server and the license 
server on the same computer, using the default port configurations.

1 Start the license server. Make sure you are in the directory where startup scripts are located.

Start the System Preferences and click Seapine License Server.

Click the lock on the Start/Stop tab to make changes.

Make sure the server is started. You should also select Start Seapine License Server when this computer 
starts up to automatically start the server.

Click Save.

2 Start the TestTrack Pro server.

Start the System Preferences and click TestTrack Pro.

Click the lock on the Start/Stop tab to make changes. 

Make sure the server is started. You should also select Start TestTrack Pro Server when this computer 
starts up to automatically start the server.

3 Start the License Server Admin Utility.

In the finder window, go to the License Server application directory. The default location is: 
/Applications/SeapineLicenseServer.

Double-click Seapine License Server Admin Utility. The license server admin utility starts.

4 Click Setup on the Seapine License Server Login dialog box to add a server connection.

The Setup Server List dialog box opens.

5 Click Add.

The Add License Server dialog box opens.

6 Enter a Server Name, Server Address, and Port Number. Click OK.

The server is added.

7 Click Close to return to the License Server Login dialog box.
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8 Login as the default administrative user. The username is Administrator and there is no password. 

By default, Administrator has full admin security rights and uses a TestTrack Pro floating license. It is 
strongly recommended that you set a password for this user after logging in.

9 Click Connect.

The License Server Admin Utility starts. You are now ready to add licenses and users.

Adding licenses
1 Click Licenses or choose View > Licenses.

The Licenses dialog opens.

2 Click Add.

The Add License dialog box opens.

3 Enter the serial number.

This field is not case sensitive. Licenses can be entered with or without dashes.

4 Click OK.

The license is added. Click Close to close the Licenses dialog.

Adding users
The license server is used to globally manager users. Global users can be shared between Seapine 
products and databases.

1 Click Users or choose View > Users.

The Users dialog box opens.

2 Click Add.

The Add User dialog box opens with the Info tab selected. Enter the user information.

3 Optionally, click the Address tab to add the company name and address.

4 Optionally, click the Email/Phone tab to add contact information.

5 Click the License tab to select the license type for the user.

If a license is not selected, the user will not be able to login or access TestTrack Pro.

6 Click the Notes tab to add any optional notes about the user.

7 Click the Security tab to set the license server security rights for the user. 

Most users do not require access to the license server admin utility.
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8 Click OK to save the information and add the user.

The users you added are global users that can be shared between Seapine products and databases.

9 Click Close when you finish adding users.

10 Quit the License Server Admin Utility but do not stop the license server.

Next, you’ll switch to TestTrack Pro and retrieve global users.

Getting starting with TestTrack Pro
1 Start the TestTrack Pro server. 

Start the System Preferences and click TestTrack Pro.

Click the lock on the Start/Stop tab to make changes. 

Make sure the server is started. You should also select Start TestTrack Pro Server when this computer 
starts up to automatically start the server.

2 Start a Web browser and enter the URL to access the Server Admin Utility.

Enter the static server address or the IP address and the path to the admin login page. 

For example: <http://127.0.0.1/ttweb/ttadmin/adminlogin.htm> or 
<http://www.yourserver.com/ttweb/ttadmin/adminlogin.htm>

3 The Welcome to TestTrack Pro - Server Admin page opens.

The Login to TestTrack Pro Server Admin dialog should automatically open. If it does not open, click Go 
To Login on the Welcome page.

4 Enter a Username and Password and click Login.

Note:  A default administrative user is added to the server admin utility during installation. 
Login as this user the first time you start the server admin utility. The username is 
Administrator and there is no password. After logging in, you add at least one admin user 
to the server.

The TestTrack Pro Server Admin Main page open

5 Add a server and create at least one database.

See the TestTrack Pro Server Admin Utility Guide for more information.

6 Next, open a web browser and enter the static server address or the IP address and the path to the 
TestTrack Pro Web login page. 

For example: <http://127.0.0.1/ttweb/login.htm> or <http://www.yourserver.com/ttweb/login.htm>
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7 Login as the default administrative user. The default administrative username is Administrator and there 
is no password.

You are now logged in and ready to start using TestTrack Pro.

8 To retrieve users from the license server click the Users tab then click Add Global.

The Add Global User to Current Database dialog opens.

9 Select the users and click OK.

The users you added to the license server can now access TestTrack Pro.

10 The installation and setup process is now complete.

i
After starting TestTrack Pro, take the time to set database options, create security groups, 
and configure TestTrack Pro to meet your company’s business process. See the TestTrack Pro 
User Guide for more information.

The servers aren’t communicating. Help!
If the servers aren’t connecting, you need to start the server admin utility and check the license server 
information.

1 Make sure the license server and the TestTrack Pro server are both running.

2 Start the TestTrack Pro server admin utility and login.

If your username and password are not recognized, you can connect with the local TTPro admin 
password, leaving the username blank and entering admin as the password. This password only 
provides access to the license server configuration.

Note:  It is strongly recommended that you change the local TTPro admin password, which 
only provides access to the license server configuration. To change this password, login to 
the TestTrack Pro server admin utility using the Administrator account or your existing admin 
username/password. Select Server Options then click the Server tab. Enter and confirm a 
new local TTPro admin password and click OK.

3 Click Server Options.

The Options window opens with the License Server tab selected.

4 Make sure the server address and port number are both correct.
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5 Click Test Connection.

A message opens, letting you know if the connection is successful. If the TestTrack Pro server and the 
license server are installed on different computers, you may need to check your network and firewall 
configurations to open the necessary ports.

6 Click OK to close the message.

If the connection was not successful, correct any mistakes and re-test the connection.

If the connection was successful, click OK to close the server options.

i
You may need to manually configure the connection if you changed the default TestTrack 
Pro or license server address or port number or you installed the TestTrack Pro server and 
the license server on different computers.

7 Stop and restart the TestTrack Pro server for the changes to take affect.

Configuring the license server
1 Start the System Preferences and click Seapine License Server.

2 Click the lock on the Start/Stop tab to make changes.

Select Start Seapine License Server when this computer starts up to make sure the server starts automatically.

3 Click the Access Options tab to configure access options.

4 Server Port specifies the port the license server uses to communicate with all clients. The license server 
reads this value when the server is first started. 



52 Chapter 4
Mac Installation

5 Reboot Port specifies the port the license server uses the next time the server is started. 

6 Startup Log Directory specifies the directory where the license server startup log file is saved.

7 Application Directory specifies the full pathname of the directory where the application is installed.

8 Short Date Format specifies the short date format you want to use. Valid date formats include: 
“%m/%d/%y”, “%d/%m/%y”, “%b/%d/%y”, or “%d/%b/%y”. 

9 Select Allow administrator to specify full path for Seapine License Server databases to allow databases to be 
created in any existing directory on the server computer’s local hard drive or on any mapped network 
drive on the server computer.

10 Force server to flush files after each database write flushes files after each database write. Selecting this 
option may slow down performance. If data is important to you, select this option to make sure you lose 
as little data as possible if the server crashes. If speed is important to you, do not select this option.

11 Click Save to save the options.

Configuring the TestTrack Pro server
1 Start the System Preferences and click TestTrack Pro.

2 Click the lock on the Start/Stop tab to make changes. 

Select Start TestTrack Pro Server when this computer starts up to make sure the server starts automatically.

3 Click the Access Options tab to configure access options.
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4 Server Address specifies the TestTrack Pro server IP address, which the CGI client uses to find the server.

5 Server Port specifies the port the TestTrack Pro server uses to communicate with all clients, including the 
TTCGI application. The TestTrack Pro server reads this value when the server is first started. Note: It is 
recommended that you change the reboot port value instead of the server port value. When the TestTrack 
Pro server is shutdown and restarted, it copies the reboot port value to the server port field.

6 Reboot Port specifies the port the TestTrack Pro server uses to communicate with all TestTrack clients, 
including the TTCGI application, the next time the TestTrack Pro server is started. 

7 CGI Binary Path specifies the relative path and filename of the TestTrack CGI application.

8 Forms Path specifies the full pathname of the directory where the TestTrack Pro HTML files are installed.

9 HTML Forms Path specifies the TestTrack Pro HTML files virtual directory. If the files are moved to a 
different URL location, the new location must be specified in the HTML forms path field.

10 Admin CGI Binary Path specifies the relative path and filename of the TestTrack Admin CGI application. 
This path is relative to the root directory of your web server.

11 Admin Forms Path specifies the full pathname of the directory where the TestTrack Pro Admin HTML files 
are installed. 

12 Admin HTML Forms Path specifies the TestTrack Pro Admin HTML files virtual directory. If the files are 
moved to a different URL location, the new location must be entered in this field.

13 Startup Log Directory specifies the directory where the TestTrack Pro server startup log file is written.

14 Application Directory specifies the full pathname of the directory where the application is installed.

15 Short Date Format specifies the short date format you want to use. Valid date formats include: 
“%m/%d/%y”, “%d/%m/%y”, “%b/%d/%y”, or “%d/%b/%y”. 

16 Select Allow administrator to specify full path for TestTrack databases to allow databases to be created in any 
existing directory on the server computer’s local hard drive or on any mapped network drive on the 
server computer.

17 Select Perform IP address check if Web user attempts to login a second time determines what action should be 
taken if a second login attempt is made via the Web interface, with the same username, from a different 
IP address. TestTrack users can only log into a database from one location at a time. If a second login 
attempt is made, the TestTrack Pro server can either deny the second login attempt or disconnect the first 
connection so the second login attempt can be accepted. 

Note:  You may not want to select this option if users connect to TestTrack via the Web, using 
an ISP. The ISP will often quickly re-assign an IP address. TestTrack sees this as a security 
threat and ends the user session. The user may lose work and will need to re-login. In 
addition, you may not want to select this option if you use NAT (Network Address 
Translation) because the external IP dress may change depending on your firewall settings. 
If it does, TestTrack ends the user session. The user may lose work and will have to re-login.
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18 Select Perform security check to insure a consistent IP address during a Web session to verify that all requests 
come from the same IP address as the original login information. TestTrack Pro server performs a security 
check to insure Web sessions are not hijacked from a different IP address. Someone may attempt to 
determine the unique session ID of a logged in user, instead of cracking a username and password.

Note:  You may not want to select this option if users connect to TestTrack via the Web, using 
an ISP. If the ISP connection is dropped, the user may be assigned a new IP address when 
a connection is re-established. If the security check is skipped, the user can continue using 
TestTrack via the current browser window. The user does not have to login again and will 
not lose any work. If this security check is performed, the user is required to login again and 
will lose any current work.

19 Click Save to save the options.
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File level security issues
TestTrack Pro can only restrict security access through the application. This does not replace the need for 
file and directory security at the operating system level. 

If security is a concern, use Windows NT/2000 with NTFS to provide increased security. You can restrict 
access to the TestTrack Pro directory through NTFS security settings. You can also restrict access for most 
users to read-only permission. TestTrack Pro users do not need write access because the server 
application does the actual writing to the database files.

The following example illustrates what can happen if users have full access:

A drive is accessible through the network and there is no file-level security on the drive. Any user can 
open and look at data/files using a program such as Notepad. Data is stored in both binary format and 
plain text. Usernames and passwords are encrypted so the user cannot access that information. In 
addition to viewing the data/files, it is possible for a user to vandalize your system by deleting files or 
even deleting the entire database.

Note:  Windows 2000 with FAT does support some security permissions.
Windows NT/2000 with NTFS is recommended if security is a concern.

Directory sharing issues
The TestTrack Pro application does not require that database files reside on a shared drive. The TestTrack 
Pro ODBC driver does require the database to be accessible via a network shared drive. There is no need 
to share the TestTrack Pro database directory if you are not planning to use the TestTrack Pro ODBC 
driver.

If you grant ODBC access to a database, users can view all TestTrack Pro data with the exception of 
encrypted usernames and passwords.

The need for file-level security is increased if you place the TestTrack Pro database on a network shared 
drive.

Note:  Windows 95/98/ME/XP does not provide file-level security because it uses the FAT 
file system.

Windows NT security is only available if you’re using the NTFS file system. It is not 
available if you’re using the FAT file system. If your PC is configured with the FAT file 
system, you can convert to NTFS through Windows commands. Refer to your Windows Help 
or contact your system administrator for more information.
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Apache software license
TestTrack includes software developed by the Apache Software Foundation (http://www.apache.org/) for the use of 
XML parsing. The following license information pertains specifically to the code written by the Apache Software 
Foundation.

The Apache Software License, Version 1.1

Copyright (c) 1999-2000 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

The end-user documentation included with the redistribution, if any, must include the following acknowledgment: 
“This product includes software developed by the Apache Software Foundation (http://www.apache.org/).” Alternately, 
this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally 
appear.

The names “Xerces” and “Apache Software Foundation” must not be used to endorse or promote products derived 
from this software without prior written permission. For written permission, please contact apache@apache.org.

Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without 
prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., 
http://www.ibm.com.  For more information on the Apache Software Foundation, please see 
http://www.apache.org.
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GDChart and GD library license

GDChart

Permission has been granted to copy, distribute and modify GDChart in any context without fee, including a 
commercial application, provided that this notice is present in user-accessible supporting documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper credit for the authors 
of GDChart, not to interfere with your productive use of GDChart. If you have questions, ask. "Derived works" 
includes all programs that utilize the library. Credit must be given in user-accessible documentation.

This software is provided "AS IS." The copyright holders disclaim all warranties, either express or implied, including 
but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to this code 
and accompanying documentation.

GD library

Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001 by Cold Spring Harbor Laboratory. Funded under 
Grant P41-RR02188 by the National Institutes of Health.

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001 by Boutell.Com, Inc.

Portions relating to GD2 format copyright 1999, 2000 Philip Warner.

Portions relating to PNG copyright 1999, 2000 Greg Roelofs.

Portions relating to libttf copyright 1999, 2000 John Ellson (ellson@lucent.com).

Portions relating to JPEG and to color quantization copyright 2000, Doug Becker and copyright (C) 1994-1998, 
Thomas G. Lane. This software is based in part on the work of the Independent JPEG Group. See the file README-
JPEG.TXT for more information.

Portions relating to WBMP copyright 2000 Maurice Szmurlo and Johan Van den Brande.

Permission has been granted to copy, distribute and modify gd in any context without fee, including a commercial 
application, provided that this notice is present in user-accessible supporting documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper credit for the authors 
of gd, not to interfere with your productive use of gd. If you have questions, ask. "Derived works" includes all 
programs that utilize the library. Credit must be given in user-accessible documentation. This software is provided 
"AS IS." The copyright holders disclaim all warranties, either express or implied, including but not limited to implied 
warranties of merchantability and fitness for a particular purpose, with respect to this code and accompanying 
documentation. 

Although their code does not appear in gd 2.0.1, the authors wish to thank David Koblas, David Rowley, and 
Hutchison Avenue Software Corporation for their prior contributions.
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gSOAP software license
The following license information pertains specifically to the gSOAP software.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2002 Robert A. van Engelen, Florida State University. All Rights 
Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GSOAP SOFTWARE AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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